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Welcome to the official Apple training course for iPhoto for Mac and 

iPhoto for iOS. You don’t need any special background to get started, other 

than having a Mac and/or an iOS device and perhaps a healthy curiosity 

about what you can do with photos using Apple products.

Learning iPhoto will teach you how to integrate your Mac and iOS device 

comfortably into your home, school, and work by weaving digital and 

mobile photography into your daily life.

In this book, we concentrate on how real people use iPhoto. We may even 

skip some of the more advanced functionality with an eye toward having 

fun, achieving quick success, and forming a foundation of confidence on 

which you can build your own uses.

Getting Started
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What iPhoto Does for You

There was a time when your photographs were in a shoebox in the closet or, maybe more 
recently, just stored on your computer or mobile device. Organization wasn’t even a con-
sideration, so finding a particular photo was a chore.

But when all your photos are digital, keeping them organized is streamlined, sharing them 
is easy, and presenting them in a variety of stunning ways is simple and fun.

A Mac is designed to sit at the heart of your digital life. It’s a computer designed for 
creativity. Furthermore, your iPhone is one of the most popular cameras in the world. 
Because Apple includes iPhoto with all current Macs and iOS devices at no charge, you 
have no better time to learn how to take advantage of iPhoto.

iPhoto teaches you visual literacy: the ability to communicate effectively through photos, a 
skill that is different from speaking or writing. Making professional-quality photo books, 
web journals, and slideshows is a skill you can apply throughout your life. Once you 
develop these skills, you’ll be stunned by how often you use them, whether for personal 
pleasure or professional advantage.

Learning software isn’t always fun; but sharing photos or creating slideshows, promoting 
your business, and building a creative report for school can be. You’ll end up learning the 
iPhoto software along the way.

The Methodology

This book moves through lessons by progressively increasing the complexity of what 
you do with photos. You start by importing and viewing still images, and then move to 
organizing and perfecting them, turning still images into moving (dynamic) images and 
exploring the possibilities of the Apple iCloud web service.

Above all, these lessons are meant to be practical—not esoteric projects to show off the 
software, but real-life projects for real-life people with time constraints and well-used 
equipment. The lessons cover iPhoto for Mac and iPhoto for iOS in two separate sections.

iPhoto for Mac OS
In Lessons 1 through 9, you’ll work with photos from the provided iPhoto library. You’ll 
import pictures from your digital camera, organize, fix, enhance, and back up your library 
of photos. In Lesson 10, you’ll share photos using iCloud and your Mac.



System Requirements  xiii

iPhoto for iOS
In Lessons 11 through 13, you’ll get a thorough walkthrough of iPhoto for iOS devices. In 
these lessons, you’ll use your own photos to follow the detailed exercises. You’ll learn how 
to move photos from your Mac to iOS, and how to tag and edit photos. Then you’ll share 
your images through photo books, slideshows, and unique web journals. In Lesson 14, 
you’ll share photos using iCloud and your iOS device.

A Word About the Lesson Contents

Often, training materials are professionally created using actors and elaborate productions 
requiring multiple cameras and a crew. The results may be of high quality, but probably 
bear little similarity to the kind of photos most families take or business owners can afford.

To make this training as real-world and practical as possible, all the media used in this book 
was made in precisely the way you make your own photos. The quality of the pictures (for 
better or worse) is comparable to what you can achieve with point-and-shoot cameras and 
the iPhone; and the sophistication of the projects is precisely what you can achieve using 
iPhoto with the same settings (and challenges) you will commonly encounter yourself.

We tried to make sure the events depicted here were recorded in the way you are being 
taught to work. Ideally, this will give you clear and realistic expectations about what you 
can do with your newfound skills.

System Requirements

This book is written for iPhoto 9.5.1 on OS X 10.9.2, which is included with any new Macintosh 
computer. It also covers iPhoto 2.0.1 for iOS devices running iOS 7.7.1 or later. If you have an 
older version of iPhoto, you will need to upgrade to the current iPhoto version to follow along 
with every lesson. The upgrade can be purchased through the Mac and iOS App Stores.

Before you begin the lessons in this book, you should have a working knowledge of your 
Mac, OS X, your iPhone or iPad, and iOS 7. You don’t need to be an expert, but you do 
need to know how to use the mouse, standard menus, and an iOS 7 touch screen.

You should feel comfortable with opening, saving, and closing apps and files on the Mac, 
and know how to tap, swipe, and pinch in iOS. You will need a working understanding of 
how OS X organizes files on your computer. If you need to review any of these techniques, 
see the printed or online documentation that came with your device.

Some exercises will require an Apple ID and an Internet connection.
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Copying the iPhoto Lesson Files

The Apple Pro Training Series: iPhoto lesson files must be downloaded to OS X to complete 
exercises in Lessons 1 through 9. After you save the files to your hard disk, each lesson will 
instruct you in their use.

To download these files, you must have your book’s access code, which is provided on a 
card in the back of the printed editions of this book, and on the “Where Are the Lesson 
Files?” page in electronic editions.

NOTE � For complete download instructions, go to the section “Downloading an 
iPhoto Library” in Lesson 1.

Resources

Apple Pro Training Series: iPhoto is not intended to be a comprehensive reference manual, 
nor does it replace the documentation that comes with the applications. Rather, the book 
is designed to be used in conjunction with other comprehensive reference guides. These 
resources include:

 � Companion Peachpit website: As iPhoto is updated, Peachpit may choose to update 
lessons as necessary. Please check www.peachpit.com/APTSiPhoto.

 � The Apple website: www.apple.com
 � Apple Pro Training Series books:

Apple Pro Training Series: iMovie, by Dion Scoppettuolo, is an excellent companion to 
this book. Learn how to use iMovie to create first-class movies, advanced slideshows, 
and fun movie trailers on both OS X and iOS 7.
Apple Pro Training Series: GarageBand, by Mary Plummer, is an in-depth look at 
GarageBand, in which you build songs, podcasts, and movie scores from scratch, 
and explore some of the advanced mixing and arranging features of GarageBand.

http://www.peachpit.com/APTSiPhoto
http://www.apple.com
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Image here is FPO. Arrangements 
for purchase and placement of 
image to follow. 
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Time This lesson takes approximately 60 minutes to complete.

Goals Name faces in your library

Confirm and reject suggestions

Add names to missing faces

Use GPS photos in Places

Place photos on a map

Add your own locations

Create Smart Albums of specific people and places

Post photos to Facebook
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In Lesson 3, you learned that rating, flagging, and assigning keywords 

to photos can make it easier to locate the photos you want to share. But 

what do you do when you want to see photos of specific people or look 

at photos taken at the cabin you rent every winter? Star ratings and flags 

don’t help much in those cases. Keywording could be useful, but I admit, 

it can be a bit time consuming. Thankfully, you can put iPhoto to work 

finding all the people and all the places in your photos.

Arranging Photos by 
Faces and Places

Lesson 4
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Finding People in Your Photos

When you organize photos in your library, the most useful information is knowing who 
is in them. iPhoto can help immensely because it not only detects people’s faces in your 
pictures (sorry Bowser and Fluffy, pets not included), it can also recognize those same 
faces throughout your library.

Using Faces View
You start using the Faces feature by putting names to faces that iPhoto detects. Once 
iPhoto has names to associate with faces, it then can suggest other photos those people 
might be in.

1 In the Source list, select Faces.

The first time you select Faces, the Find corkboard is shown with a few people from 
your library displayed as starting points. iPhoto found these faces in your library but 
has no idea who they are. It’s up to you to add their names.

NOTE � If you see more than three faces, reduce the window size by dragging the 
lower-right corner. Doing so will help you follow the examples shown in this lesson.

2 Click the “unnamed” label below the boy’s picture.

3 Type Damon, and click the small girl’s picture.
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4 Type Mia, and click the last picture, the woman.

5 Type Mom, and press Tab to confirm the final name.

iPhoto could continue finding faces for you to name if you clicked the Show More Faces 
button; but for our purposes, three people are enough to learn this feature.

Confirming and Rejecting Suggestions
When you have placed a name to a face, iPhoto can continue to search your library and 
suggest other photos featuring that person.

1 Click the Continue To Faces button.

The Faces view shows a snapshot for each person you’ve named on a corkboard back-
ground. The snapshot represents a group of all the confirmed photos of that person in 
your library—right now, just one photo for each person. So next you can find more.

You can add an email address by clicking the Info button while in Faces view. 
When photos of that person are posted to Facebook, the person will be notified via a 
Facebook message.
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2 On the corkboard, double-click the snapshot of Damon to view all the photos that 
have been confirmed to include him.

iPhoto has found only one photo so far, the one you named. A message indicates that 
other Damon photos may exist.

3 In the lower right of the window, click Confirm Additional Faces to show pictures 
that may include Damon.

iPhoto displays photos it thinks include Damon, zoomed in to his face. It’s up to you 
to confirm or reject the identification.

If you want to see the entire photo instead of just the face in Faces view, click 
the switch in the upper right of the window to switch from Faces to Photos.

4 Click the first photo below the unconfirmed faces banner to confirm it as Damon. A 
green title bar indicates that this photo has been confirmed.

If you have more than one photo to confirm, you can speed up the process by drag-
ging a selection rectangle around all of the photos.
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5 Drag to select the remaining unconfirmed photos on the top row.

6 Click Done.

Using the confirmed photos as additional reference, iPhoto now has a better idea 
what Damon looks like. A message informs you that iPhoto has found still more pho-
tos that may include Damon.

7 Click Confirm Additional Faces.

8 Select the pictures that include Damon.

A few photos, however, are not Damon but a girl. The girl has a resemblance because 
she’s his sister, but you’ll want to reject these photos.

9 Double-click any photos that are not Damon, to reject the identification of these photos. 
When you do, a red title bar indicates it is not Damon.



58   Arranging Photos by Faces and Places

10 Click Done, then in the Source list, select Events.

You can remove a subject from the Faces view by selecting the snapshot on 
the corkboard and pressing Command-Delete.

With all of Damon’s photos located, you could proceed to the next snapshot on the Faces 
corkboard and have iPhoto locate photos of other people. Face-recognition technology 
is still in its infancy, so be prepared to find some suggestions that seem way off and even 
some instances when a face can’t be found at all. The iPhoto recognition skills are remark-
able but not infallible.

Putting Names to Faces
iPhoto does a pretty good job of finding and identifying faces. When you view a photo 
with the Info pane open, iPhoto will often suggest the name of someone in the photo. If it 
can’t identify a face, it will ask you to do so.

1 In the Source list, select Events, and then double-click The Krupps Family event.

2 Scroll to find the photo of the family at the picnic table, and double-click the photo to 
display it in the viewing area.
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3 Click the Info button.

In the Info pane, information about the faces found is shown on the photo.
iPhoto identifies Damon in the photo and wonders about Mom but can’t figure out 
who the other faces belong to. You can confirm that it is indeed Mom and name the 
other people found in the photo.

4 Click the checkmark on Mom’s nametag to confirm her identification.

At times iPhoto may incorrectly detect a pattern in your photo as a face. 
To remove a face detection box from a photo, click the X in the upper-left corner 
of the box.

5 Click the unnamed tag for the small girl, and type Mia.

6 Click the unnamed tag for the man in the photo, and type Dad.

Click the arrow on the Faces nametag to go to the Faces page for that person.

7 Click the Info button to close the Info pane, and then in the Source list, select Events 
to return to the Events view.

You can continue going through photos like this to confirm and name additional people that 
iPhoto finds. The end results are the same as using the Confirm Additional Faces button in 
the Faces confirmation window.

Adding Missed Faces
In some photos, people may be turned away from the camera or wearing a hat and glasses. 
As a result, iPhoto cannot recognize them or even recognize that a face is in the photo. 
Still, you may want to identify those photos as including a particular person. iPhoto allows 
you to identify and name a face even when iPhoto can’t.

1 Return to view The Krupps Family event.
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2 Scroll to find the photo of Mia hiding behind a mask, and double-click the photo to 
display it in the viewing area.

3 Click the Info button.

The Info pane opens but no face is detected, as in the previous photo.
It’s obvious why iPhoto doesn’t find the girl’s face, but this is still a fun photo you 
would want to find when looking for photos of Mia. You can help iPhoto solve the 
mystery of who is in this picture.

4 In the Info pane, click “Add a face.”

A rectangular outline appears on the photo. You can resize and reposition this rect-
angle to frame the face.

5 Drag any of the handles at the corners of the rectangle to increase the size of the rect-
angle to fully outline the girl’s face.



Finding People in Your Photos  61

6 Drag in the center of the rectangle to center it over the face.

7 Add Mia’s name to the nametag, and then select her from the list.

The payoff for all this naming is that you can find photos of your family members in an 
instant—no more searching for hours to dig up one picture you know you kept some-
where. You can even make the searching easier by combining Faces with Smart Albums.

Creating a Faces Smart Album
After you have applied names to Faces, you can create Smart Albums based on the people 
identified in your photos.

1 In the Source list, select Faces.

2 Command-click Mia’s and Damon’s snapshots.
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3 Drag the two snapshots to an empty area of the Source list.

A Smart Album is automatically created with the name “Damon or Mia.” The Smart 
Album will find all the photos featuring either child, or you can choose to edit the 
Smart Album’s conditions as you did in Lesson 3.

4 Choose File > Edit Smart Album.

The Smart Album conditions open showing the search for two faces: Damon’s and 
Mia’s. At the top of the dialog, a condition is set to match any of those two conditions.

5 Set the pop up menu from “any” to “all,” and then click OK.

The Smart Album updates to show only those photos that include both Damon and 
Mia, not Damon or Mia. That being the case, you’ll edit the name of the Smart Album 
to reflect the change.

6 Click the name of the Smart Album, and type Damon and Mia.
In the future whenever you add new photos that include Damon and Mia, they automati-
cally will be added to this smart album.

Finding Places
Based on the last exercise, you can now find photos according to who is in them. Wouldn’t 
it be just as nice to find photos based on where you took them? In iPhoto, you can map 
each photo’s location within mere feet of where you were standing.

Places view uses GPS information to automatically identify where photos were taken; or if 
GPS isn’t available on your camera, you can add your own location information by tagging 
the photo with a country, state, city, or point of interest. iPhoto instantly gives you a list of 
locations to choose from.

NOTE � To use Places view, you must be connected to the Internet. The Places maps 
and list of locations are not stored on your hard disk, which enables them to be 
updated regularly.
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Viewing GPS-Tagged Images in Places
You can now buy cameras with built-in GPS capabilities. These cameras will save the location 
where each picture was taken, just as transparently as they save the picture’s date. If you own 
an iPhone, you already have a GPS-equipped camera that works with the iPhoto Places view.

In the Places view, a map shows where all of your photos were taken. If your pictures have 
GPS information already embedded, the entire process is done for you.

1 In the Source list, select Places.

The viewing area changes to show a map of the world. The red pins on the map indi-
cate where photos in your library were taken.

2 Drag the map to the left to view Europe. 

When using a Magic Mouse or a Multi-Touch track pad, you can pan the 
map by sliding a finger up, down, left, and right.
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3 Click the red pin in central Italy.

When you click a pin, a label appears showing the name of the location.

NOTE � Multiple photos taken in one general area may appear as a single pin until 
you zoom in to the map.

4 Click the arrow to the right of the pin’s name. The viewing area shows the photos 
taken in Rome.

5 Click the Info button to display the Info pane.

The Info pane shows the precise location of each photo in a small map pane.

6 Click the Map button to return to the Places view.

You can see a more detailed map of an area by dragging the Zoom slider, or choosing 
from the pop-up menus at the top of the map.

7 Choose States > Hawaii.

The map zooms in to view only those pins located in Hawaii. The pins identify loca-
tions on different islands.
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You can change the map style by clicking the Terrain, Satellite, or Hybrid 
view buttons.

8 To see all of your pinned photos, click Show Photos.

Instead of seeing only one pin’s photos, you can now see the photos from all the pins 
currently displayed on the map.

9 Click the Info button, then select the first photo in the viewing area. The map updates 
to show you the location of the selected photo.

10 Click the last photo in the viewing area.
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The map updates again. The title at the top of the map reads “USS Arizona Memorial” 
because iPhoto not only identifies the city or town you are in, it can also locate points 
of interest.

When photos include GPS information, the location information is saved with the photo 
as longitude and latitude. Instead of showing you the longitude and latitude values, iPhoto 
calculates the region, city, and point of interest that those numbers correspond to and 
displays that information. But what if you are using a camera without GPS? Even then, it 
doesn’t take much more than a few clicks to put those photos on the map.

Assigning a Location in Places
Even without GPS data, you can add pictures and entire events to your Places view.

1 To add a location for an entire event, in the Source list, select Events.

2 Click once to select The Krupps Family event.

The event highlights with a yellow outline. The photos in this event have no GPS 
information. Instead of assigning a location for each photo, you can assign a location 
to the entire event.

3 Click the Info button to open the Info pane, if necessary.

The Info pane map is empty. The easiest way to add a location is to add it to an entire 
event.
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4 Above the Info pane’s map, click “Assign a Place,” and type California. iPhoto searches 
for California and provides a list of locations that match.

5 Select the first item in the list: California, United States. The entire event and all the 
photos in it are now represented by the single pin you just placed.

6 To display the entire state of California, click the Zoom Out (–) button to zoom out 
on the map.

7 In the Source list, select Places to open Places view.

8 From the pop-up menus, choose Countries > United States.



68   Arranging Photos by Faces and Places

The map zooms in to show Nevada, Hawaii, and California only because no photos in this 
Library were taken farther east within the United States. If your library is small or you 
have some photos you would like to locate more precisely, you can select those individual 
photos and follow the preceding steps to assign them to more specific locations.

Moving a Pin
When you assign a location for pictures or events, iPhoto places the pin at the center of 
the location. That’s acceptable if you are at the Eiffel Tower, but not so great when you 
assign Alaska. Rather than choosing the dead center of a large area, you can move a pin to 
an exact location in just a few simple steps.

1 In the Source list, select Events, and then double-click the Mediterranean Vacation 
event.

2 Scroll down and select the photo of the goats on the hillside.

3 Click the Info button to open the Info pane, if necessary.

Like the Krupps event, this picture has no location information, but we know it was 
taken in Montenegro.

4 Above the Info pane’s map, click “Assign a Place,” and type Montenegro.
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5 Select Montenegro, the first item in the list, to assign the location.

To be more precise, you can move the pin to show exactly where this photo was taken.

6 Triple-click the Zoom Out (–) button to get a wider view of the entire country.

7 Click the red pin and hold down the mouse button until the pin lifts up. Then drag 
down the pin until it is near the little inlet near the Croatian border.

8 Release the mouse button to drop the pin at the new location.

Dropping the pin while the map is so far zoomed out was not very precise. You can 
zoom in to the map to more specifically identify the location.

9 Triple-click the Zoom In button (+) to get a closer view of the area.

10 Refine the pin’s position so it sits over the town of Kotor.

With the pin set correctly, you can assign other photos taken in that area to the same location.
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Copying a Location to Other Photos
The quickest way to set a photo location is to copy and paste the location from another 
photo taken at the same place.

1 Click the Mediterranean Vacation button to return to the Events view with all the photos.

2 Select the goat photo to which you assigned the Kotor location, and choose Edit > Copy.

3 From the row above, select the photo of the ship entering the port of Kotor, 
Montenegro.
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4 Shift-click the photo of the ice cream store in the row below the goats.

5 Choose Edit > Paste Location.

The location you copied from the goats is added to all the selected photos, which you 
can then view using Places or in the Info pane.
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Removing a Pin
Occasionally, when setting locations in groups as you just did, you may end up placing a 
photo incorrectly. For instance, say you placed an ice cream shop in Montenegro when it 
was actually located someplace else. In that case, you’ll want to remove the incorrect loca-
tion before it causes an international incident.

1 Still viewing the Mediterranean Vacation photos, double-click the ice cream store 
photo from the previous exercise. (Yes, it is upside down. You’ll deal with that in an 
upcoming lesson.)

2 Click the Info button to open the Info pane, if necessary.

3 Double-click the location name above the map to highlight it.

4 Click the X that appears to the right of the name.
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5 Double-click the ice cream store photo to view all of the photos in the event.

The location name field is cleared, and the map disappears from the Info pane.

Changing a Location Name
The name that iPhoto assigns to a location is customizable. For instance, if you take a 
picture at your friend’s house, iPhoto will locate the house correctly, but you will probably 
want to call it “Giuseppe’s House,” rather than 1234 Elm St. The same problem exists with 
the Mediterranean vacation photos. iPhoto has generically called the location Montenegro, 
but in this exercise you’ll more specifically identify it as the Gulf of Kotor.

1 Select the goats photo again, and in the Info pane, click the pin on the map to display 
the Location Name pop-up menu. 

2 Double-click the name “Montenegro” to select it for editing.

3 Type Gulf of Kotor, and then click the checkmark to confirm the new name of the pin.

The nice thing about copying this location, as you did earlier, is that when you change 
the location name for the goats photo, other photos with the same location also update.

4 Double-click the goat photo to see all the photos in the event.

5 Click to select the photo of the ship pulling into the Gulf of Kotor. Notice that each 
photo is updated to show the change in location name.
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Managing Places
When you are identifying an area such as a gulf or a national park, a single pin can’t 
always represent a large location accurately. For any name you enter as a customized loca-
tion, iPhoto allows you to set the area represented by that pin as part of the pin’s location. 
Any subsequent photos taken within that area will be assigned the correct location.

1 Select the goats photo.

2 Click the Info button to close the Info pane.

3 Choose Window > Manage My Places.

The Manage My Places window shows the pin for the currently selected photo. The 
purple circle around the pin represents the location’s area.
The circle should be large enough to encompass all of the places nearby where you are 
likely to snap a picture, so it should be made larger. In this case, it should cover the 
entire gulf.

NOTE � Locations that iPhoto already knows will have a predefined area. Only places 
you create are shown in the Manage My Places window.

4 Click the Zoom Out button (–) six times.
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5 Drag out the circle’s handles to increase its size and encircle the entire gulf area.

6 Click Done to close the Manage My Places window.

To remove a location you have added, in the Manage My Places window, click 
the minus sign to the right of the location name.

You’ve now created an enlarged area for the Gulf of Kotor. Next time you enter a new cus-
tom name for a pin, you can use the Manage My Places window to refine the area around 
it. The more precise you are in configuring Places, the more effectively the feature will 
help you find photos.

Creating a Smart Album from a Map
Now that you have tagged your photos with location information, you can create geogra-
phy-based Smart Albums.

1 In the Source list, select Places.

2 Drag the Zoom slider and pan the map to view just the three pins located in Italy 
(Hint: it’s the one that looks like a boot).
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3 Click the Smart Album button.

A new Smart Album named Italy is created in the Source list.

4 In the Source list, select the new Italy Smart Album.

The viewing area displays the photos from that Smart Album. The Info pane shows 
the map that defined which photos are included in the Smart Album.

5 Click the Info button to view the Info pane and the map for the photos in the 
Smart Album.

In the future, when you add any images to your library from your annual summers in 
Italy, the new photos will automatically be added to that Smart Album.
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Posting to Facebook, Flickr, and Twitter

Sharing photos on social media websites is so common your mom probably does it. So 
why don’t you? iPhoto can seamlessly share photos to the most popular photo sharing 
sites: Facebook, Flickr, and Twitter.

NOTE � You must have an Internet connection and Facebook, Flickr, or Twitter 
accounts to perform the next three exercises. If you don’t, you can register for 
Facebook, Flickr, and Twitter at no charge.

Posting to Facebook
Facebook is the most popular photo-sharing site on the web. You can select a single photo, 
an album, or even an entire event to post on Facebook.

NOTE � The steps to share to Facebook are very similar to the steps for sharing to 
Flickr and Twitter. Because the steps are so similar, this section details sharing to 
Facebook only, and later lists some benefits of each site.

1 In the Source list, select the Italy Smart Album.

2 In the toolbar, click the Share button, and then click Facebook.

When you share a single photo to Facebook, you have the option to make it 
your profile picture or add it to your wall.
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If you’ve never previously shared to Facebook from iPhoto, the login window opens.

3 In the login window, enter your Facebook name and password.

4 Select the “I agree to Facebook’s terms” checkbox, and then click Login.

NOTE � When you enter a user name and password for a Facebook, Flickr, or Twitter 
account, the account is added to your Sharing Preferences so you will not have to log 
in again to share additional albums to these sites.

A side window appears from the lower-right corner with options to publish the photo 
to a new album, an existing album, or your timeline. The Source list also shows a 
Facebook album for the account you entered.
The Facebook album shows all the photos you’ve previously published to Facebook.

5 Click the New Album button to open the Publish window.

To add photos to an existing album, log in to Facebook from iPhoto, select 
the photos, choose Share > Facebook from the toolbar, and then select the existing 
album from the window.

6 Enter the album’s name and who can view it, and then click Publish.

To remove a Facebook, Flickr, or Twitter account from iPhoto, delete the 
account in the Sharing tab of iPhoto preferences.

When your photos are uploaded, you can select the Facebook album in the Source list 
to view all the albums you’ve posted to Facebook. In the Info pane, you can choose 
who can view the albums on Facebook.

To delete an album from Facebook, Flickr, or Twitter, select the published 
album in iPhoto and then press Delete.

Now that you know how to share photos with Facebook, you can follow the same steps 
when you choose to share with either Flickr or Twitter.

Differences in Posting to Flickr
Flickr has some unique benefits that may entice you to post your photos there:

 � Flickr is the only site that will display iPhoto keywords.
 � If the “Include location information for published photos” checkbox is selected in the 

Web section of iPhoto preferences, Places information will appear in Flickr.
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Differences in Posting to Twitter
Twitter has a unique interface that may entice you to “tweet” your photos. Here are the 
most important differences:

 � Twitter is limited to 140 characters in a tweet. Your photo takes up 21 characters, so 
you are limited to adding 119 characters when a photo is attached.

 � Unlike Facebook and Flickr, where you can add your account from the iPhoto preferences 
window, you must add your Twitter account from the OS X System Preferences.

Lesson Review
1. In Faces view, how do you reject a photo when the person iPhoto suggests is not correct?
2. Where is the button to create a new Smart Album based on the Places view?
3. How do you add a name to a face that has not been identified by iPhoto?
4. Why would a pin not appear in the Manage My Places window?
5. To what three social media websites can you post photos directly from iPhoto?
6. How do you know which .iPhoto library photos you have posted to Facebook?

Answers

1. Double-click the photo you want to reject, and click Done.
2. When Places is selected in the Source list, the Smart Album button is located in the 

lower-right corner of the iPhoto window.
3. Display the photo in the viewing area. Click the Add Faces button, and position a 

rectangle over the subject’s face. Finally, type the subject’s name in the name tag.
4. Only pins for which you type a custom name will appear in Manage My Places. 

Pins with names provided by iPhoto will not appear.
5. Facebook, Flickr, and Twitter
6. View the Facebook album in the Source list.
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Numbers
480p (standard 

definition), 178–179

A
Accounts

removing social media 
accounts, 78

setting up email 
accounts, 19

Adjust tab
correcting exposure, 

111–112
of Edit pane, 109

Adjustments, undoing, 
289–290

Albums
Camera Roll. 

see Camera Roll
choosing photos for 

sharing, 370
creating slideshows, 

164–165
My Photo Stream. 

see My Photo 
Stream

organizing photos 
into, 251–252

posting photos to 
Facebook, 77–78

Smart Albums, 47–48
viewing photos by, 

14, 230
working with, 44–47

Alignment, entering 
and formatting text, 
156–157

All Pages view
adding unplaced 

photos, 145
deleting photos or 

pages, 141
viewing entire book, 

146, 148, 152
Antique effect, 101
App Store, 196
Apple ID

getting started with 
iCloud, 196–198, 
358–359

ordering photo books, 
158

setting up Windows 
PC for use with 
iCloud, 202

using iCloud with 
iPhoto, 358

Apple printing service
international 

availability, 134
ordering books from, 

157–158
Arrow keys, for 

navigating photos, 15
Aspect ratio

common examples, 
84–85

cropping and, 279–280
slideshow settings, 177

Attachments, photos 
to email, 23

Auto Enhance option, 
photo adjustments, 
290–292

Automatic Import, from 
My Photo Stream, 
203–204

Automatic Upload, to 
My Photo Stream, 
203–204
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B
B & W effect

applying effects to 
photos, 154–155

stylizing photos, 273
Backing up

to external hard drive, 
191

overview of, 189
to recordable DVD 

disc, 191–193
restoring library from 

backup, 189–190
Backup hard drive, 191
Beaming photos, 233–236
Black & White effect. 

see B & W effect
Black Point Levels 

slider, 116
Books

keepsake book. 
see Keepsake book

photo book. 
see Photo books

Brightening photos
with exposure 

controls, 284
with Lighten brush, 

294–295
Brightness, effects 

options, 101
Brushes

enhancing photos, 
293–296

erasing brush strokes, 
296–297

managing strength 
of, 296

repairing photos, 
298–300

resizing, 94

C
Camera Filters effects 

group, 275
Camera Roll

flagging photos, 
254–256

saving photo from 
My Photo Stream, 
364–368

saving photos from 
email, 233

Cameras, importing 
photos from, 240

Center Alignment, 
entering and 
formatting text, 
156–157

Chronological order, 
grouping photos 
by, 229

Collections, viewing 
photos by, 230

Color
effects options, 101
fixing white balance, 

287–289
increasing saturation, 

118–119
slider for adjusting 

saturation, 
288–289

Command-N (New), 45
Comments, on shared 

photos, 219–221, 
378–380

Comparing photos, 
34–36, 258–261

Compression, photo 
formats and, 182

Conditions
adding to Smart 

Albums, 48

creating Smart Album 
from Faces, 62

Contrast
adding with contrast 

slider, 113–114
applying effects, 

101, 103
increasing/decreasing, 

286
Control-click (right-click)

opening Photo 
pop-up menu, 30

retrieving photo from 
trash, 17

Copy command, copying 
locations to other 
photos, 70–71

Corkboard. 
see Find corkboard

Cropping photos
accessing Crop tool 

from Edit pane, 83
aspect ratio and, 

279–280
overview of, 82–84, 

277–279
rule of thirds and, 

85–87
straightening photos 

with Crop tool, 
281–283

D
Darkening photos, 

284–287
Date

changing date and 
time of video clip, 
187–188

sorting photos by, 28
splitting events 

by, 183
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Definition, increasing, 
120–121

Deleting
photos, 15–18
photos from 

slideshows, 
166–169

photos or pages from 
keepsake book, 
141–143

projects, 353–354
De-noise slider

care in use, 124
using in conjunction 

with Sharpness 
slider, 126

Design pop-up menu
changing page layout, 

135–137
selecting page 

layout, 139
Detect Edge button, 

brushes and, 296
Dock, opening iPhoto 

from, 3–4
Downloading iPhoto 

library, 5
DVD-R disc, exporting 

photos to, 191–193

E
Edge Blur effect

applying to photo, 154
applying to 

vignette, 102
Edit Keywords option, 

Manage My Keywords 
window, 40–41

Edit pane
Adjust tab, 109
Crop button, 83

Effects tab, 100–104
Enhance button, 

88, 96
Fix Red-Eye button, 89
opening, 82
Quick Fixes, 97
Retouch tool, 93–96
Rotate tool, 96
Straighten tool, 91–92
Undo button, 95

Edit view
comparing photos, 35
copying locations 

to other photos, 
70–71

Editing photos
applying effects, 

100–104
aspect ratios and, 

84–85
Auto Enhance option, 

290–292
brightening and 

darkening photos, 
284–287

cropping photos, 
82–84

enhancing photos, 
293–296

erasing brush strokes, 
296–297

fixing white balance, 
287–289

nondestructive, 81
photos and text in 

keepsake book, 
153–155

Quick Fix 
enhancements, 
87–88

removing red-eye, 
89–91

repairing photos with 
brushes, 298–300

retouching photos, 
93–96

review, 301
rotating photos, 

96–99
rule of thirds and, 

85–87
sharing and, 271
straightening photos, 

91–92
undoing adjustments, 

289–290
Editing photos, advanced

adding contrast, 
113–114

adjustments using 
Levels slider, 
115–118

applying sharpening 
and noise 
reduction, 
124–126

correcting exposure, 
111–112

histograms for, 
108–110

improving highlight 
detail, 121–122

improving shadow 
detail, 122–123

improving white 
balance, 126–128

increasing color 
saturation, 
118–119

increasing definition, 
120–121

perfecting 
pictures, 107
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Effects
antique option, 101
applying B & W effect 

to photo, 154
applying generally, 

100–104
applying to photos in 

keepsake book, 
154–155

for brightness and 
shadows, 103

button options, 101
changing strength 

of, 276
Ken Burns effect. 

see Ken Burns 
effect

overview of, 100
removing, 102, 274
replacing with other 

effects, 275–277
stylizing photos with, 

272–275
vignette option, 

101–102
Email

adding email address 
in Faces view, 55

adding photos from, 
232–233

adding text, 23–24
attaching photos, 23
emailing photos, 

18–20
moving and framing 

photos in theme, 
22–23

placing photos into 
email theme, 
20–21

selecting email 
provider, 19–20

Enhance button, 
Edit pane, 88, 96

Eraser button, erasing 
brush strokes, 296–
297

Events
adding descriptions, 

182–183
assigning location 

information, 
66–68

changing key photo 
of, 188–189

choosing photos for 
sharing, 370

Events option of 
Source list, 17

merging, 186–187
moving photos 

between, 185–186
organizing photos by, 

10
sorting photos by, 28
splitting, 183–184
viewing photos by, 

11–13
Exporting

photos to recordable 
DVD disc, 191–
193

slideshows, 178–179
Exposure

brightening and 
darkening photos, 
284–287

checking with 
histogram, 109–
110

correcting, 111–112
Quick Fixes, 87

Extra-large (XL), selecting 
book type, 133

Eyedropper tool, 
improving white 
balance, 126

F
Facebook

adding email 
addresses in Faces 
view, 55

posting photos to, 
77–78

removing iPhoto 
accounts, 78

sharing photos via 
social media, 
304–306

Faces view
adding missed faces, 

59–61
confirming or 

rejecting 
suggestions, 
55–58

creating Smart Album 
from Faces, 61–62

finding people in 
photos, 54–55

putting names to 
faces, 58–59

removing subject 
from, 58

review, 79
Fade effect, applying 

to photo, 154
Favorites

collecting favorite 
photos, 253–254

comparing photos 
and tagging 
favorites, 260
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Files
exporting photos to 

recordable DVD 
disc, 192

importing video clip 
into slideshow, 
173–175

understanding photo 
formats, 182

Filtering displayed photos, 
with thumbnail grid, 
268–271

Find corkboard, 54–56
Five-star rating system, 

29–32
Fix Red-Eye button, 

Edit pane, 89
Flagging photos

cropping and, 87
enhancing photos 

and, 88
fixing red-eye and, 91
overview of, 32–34, 

254–256
retouching photos 

and, 96
straightening photos 

and, 92
unflagging photos, 36

Flickr
posting photos to, 78
removing iPhoto 

accounts, 78
Focus, checking, 266–268
Fonts, text, 156
Formats

photo formats, 182
text formats, 155–157

Framing photos
in keepsake book, 

143–145

in web journal, 321, 
325–328

Full Screen option, for 
viewing photos, 14–15

G
Gestures, for panning 

maps, 63
GPS, viewing GPS-tagged 

images, 63–66

H
Hard drives, backing up 

to external, 191
Hardcover option, 

selecting book type, 
133

Highlights
applying effects, 103
darkening, 285
histograms for 

analyzing, 
108–110

improving detail, 
121–122

Levels slider for 
adjusting, 115

Histograms
adding contrast, 

113–114
correcting exposure, 

111–112
how they work, 

108–110
modifying levels, 

115–118
overview of, 108

I
iCloud

getting started, 
196–197

setting up on Mac 
computers, 
197–201

setting up on 
Windows PCs, 
201–203

sharing photos, 
208–210

sharing slideshows, 
314–316

sharing web journals, 
328–330

uploading photos 
manually, 
203–204

what it is, 196
iCloud, on iOS devices

adding to shared 
photo streams, 
372–375

commenting on 
shared photos, 
378–380

creating shared photo 
streams, 369–372

deleting shared photo 
streams, 374

getting started, 358
iCloud Photo Sharing 

service, 368–369
removing items from 

My Photo Stream, 
360–364

removing items from 
shared photo 
streams, 376–378

review, 378–380
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saving photo to 
Camera Roll, 
364–368

setting up, 358–359
sharing using My 

Photo Stream, 358
what iCloud is, 357

iCloud Photo Sharing 
service
Apple web 

services, 357
overview of, 368
setting up, 369

Import to Library, 
adding video clip to 
slideshow, 173–175

Importing photos
from a camera, 9–11
from camera or 

memory card, 240
from My Photo 

Stream, 206–208
Information pane

adding email 
addresses 
in Faces view, 55

adding event 
descriptions, 
182–183

adding keywords to 
photos, 37–39

adding missed faces, 
60–61

adding names to 
faces, 58–59

assigning location 
information to 
events, 66–68

closing, 39
commenting on shared 

photos, 220

creating Smart 
Albums from 
maps, 76

moving location pins, 
68–69

opening, 37
removing location 

pins, 72
viewing location 

information, 
64, 248

viewing photo 
information, 
12–13

Instant slideshows
types of slideshows 

in iPhoto, 161
using, 162–164

Internet connection
downloading an 

iPhoto library, 5
getting started with 

iCloud, 196, 358
My Photo Stream 

and, 207
Places view and, 62
sharing slideshows 

and, 315
sharing via social 

media and, 77
sharing web journals 

and, 329
iOS devices. see also by 

individual devices
adding photos from 

email, 232–233
beaming photos, 

233–236
deleting photos, 

244–247
iCloud on. see iCloud, 

on iOS devices

importing photos 
from camera or 
memory card, 240

overview of, 225–226
review, 249
syncing photos from 

Mac or Windows 
PCs, 236–239

viewing albums, 230
viewing photo 

location, 248
viewing photos, 

227–229, 241–244
viewing projects, 231

iPad. see also iOS devices
iCloud and, 196
removing items 

from My Photo 
Stream, 363

removing items from 
shared photo 
stream, 376–378

saving photos to 
Camera Roll, 
365–368

sharing 
slideshows, 178

transferring 
photos to, 49

iPhone. 
see also iOS devices
adjusting aspect 

ratio, 177
iCloud and, 196
removing items from 

shared photo 
stream, 376–378

removing photos 
from My Photo 
Stream, 363
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saving photos to 
Camera Roll from 
My Photo Stream, 
365–368

sharing slideshows, 178
transferring photos 

to, 49
iPhoto window, 

navigating, 6
iPod. 

see also iOS devices
sharing 

slideshows, 178
transferring photos 

to, 49
iTunes

adding music to 
slideshows, 307

changing slideshow 
themes and 
music, 170–171

exporting slideshows, 
178–179

iCloud and, 196, 358
selecting music for 

slideshow, 163
sharing 

slideshows, 314
sharing web 

journals, 328
transferring photos to 

mobile devices, 
49–50

J
JPEG file format

converting to, 192
understanding photo 

formats, 182

K
Keepsake book

adding unplaced 
photos, 145–148

changing page layout, 
135–137

creating layout 
for, 131

deleting photos or 
pages, 141–143

editing photos and 
text in, 153–155

entering and 
formatting text, 
155–157

framing photos on 
pages, 143–145

integrating map into, 
148–152

ordering printed 
copies, 157–158

rearranging pages, 
152–153

review, 159
selecting page layouts, 

137–141
selecting theme for, 

132–135
Ken Burns effect

changing slideshow 
themes and 
music, 170–171

creating 
slideshows, 307

disabling, 177
modifying pan and 

zoom of, 171–173
Key photo

changing key photo of 
an event, 188–189

default views and, 11

Keywords
assigning to photos, 

36–39
Flickr displaying, 78
managing, 40–43
searching iPhoto 

library by, 43–44
tagging photos with, 

256–258

L
Layout

changing page layout, 
135–137

creating for keepsake 
book, 131

customizing cover 
of photo book, 
333–334

entering and 
formatting text, 
155–157

framing photos on 
pages, 143–145

Page Layout popover, 
344–345

selecting page layout 
for book, 137–141

of web journals, 
318–320

Layout pop-up menu, 
Map option, 150

Levels slider
adjusting photos, 115
Black Point Levels 

slider, 116
Midtones Levels 

slider, 117–118
White Point Levels 

slider, 116–117
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Library
backing up, 189
downloading, 5
dragging photos to 

slideshow, 166
exporting photos to 

recordable DVD 
disc, 191–193

importing video clip 
into slideshow, 
173–175

navigating iPhoto 
window and, 6

overview of, 3–4
restoring with Time 

Machine, 189–190
review, 7
saved slideshows 

in, 161
searching, 43–44
switching between, 

6–7
transferring photos to 

mobile devices, 
49–50

Lighten brush, 
brightening photos 
with, 294–295

Lighten option, applying 
effects, 103

Local contrast 
(definition), 120

Locations. 
see also Places view
adding/removing, 

150–151
assigning, 66–68
changing names, 73
copying to other 

photos, 70–71
moving location pins, 

68–69

removing location 
pins, 72–73

viewing photo 
location on iOS 
devices, 248

Loupe tool
checking focus, 

266–268
fixing skin tones, 288

M
Mac computers

adding photos to 
shared photo 
streams, 216

commenting on shared 
photos, 220

creating shared photo 
streams, 210–212

deleting entire photo 
stream, 214

importing photos 
from My Photo 
Stream, 207

removing photos 
from My Photo 
Stream, 205–206

removing photos 
from shared 
photo streams, 
217–218

setting up iCloud 
photo sharing, 
197–201, 208–209

syncing photos from, 
237–238

uploading photos to 
My Photo Stream, 
203–204

Magic Mouse, 63
Mail app, 232–233. 

see also Email

Manage My Keywords 
window, 40–43

Manage My Places 
window, 74–75

Managing photos
adding event 

descriptions, 
182–183

backing up 
photos, 189

changing dates and 
time, 187–188

changing key photo 
of an event, 
188–189

exporting photos to 
recordable DVD 
disc, 191–193

merging events, 
186–187

moving photo 
between events, 
185–186

overview of, 181
restoring library, 

189–190
review, 193
splitting events, 

183–184
understanding photo 

formats, 182
using backup hard 

drive, 191
Map option, Layout 

pop-up menu, 150
Maps

adding to photo book, 
340–343

adding to web 
journal, 322–323

creating Smart Album 
from, 75–76
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integrating into 
keepsake book, 
148–152

viewing GPS-tagged 
images, 64–66

Match pop-up menu, 
conditions, 48

Matte effect, 154
Memory cards

erasing, 11
importing photos 

from, 240
opening iPhoto when 

connecting to, 
9–10

Merging events, 186–187
Midtones

adjusting, 115
analyzing, 108–110
brightening or 

darkening 
photos and, 286

Midtones Levels 
slider, 117–118

Mobile devices, 
transferring photos 
to, 49–50. 
see also iOS devices

Modern Lines, selecting 
book theme, 134

Mouse pointer, crosshair 
option, 83

.MOV files, 173–175
Multi-Touch track pad, 63
Music

adding to 
slideshows, 307

changing in 
slideshows, 
170–171

slideshow themes 
and, 163

My Photo Stream
Apple web services 

and, 357
importing photos 

from, 206–208
limit in term of items 

in, 372
overview of, 197
removing photos 

from, 205–206, 
217–219, 360–364

saving photos to 
Camera Roll, 
364–368

setting up iCloud 
on iOS devices, 
358–359

setting up iCloud on 
Mac computers, 
199–201

setting up iCloud on 
Windows PCs, 
201–203

setting up photo 
sharing, 208–210

sharing using, 358
uploading photos to, 

203–204
My Rating

conditions, 48
viewing ratings, 32

N
Names

changing location 
names, 73

putting names to 
faces, 58–59

Navigation window, 
viewing areas of 
zoomed image, 
93–95

Noise reduction, 124–126
Nondestructive editing. 

see also Editing 
photos
cropping photos as 

example of, 84
overview of, 81
sharing photos 

and, 271
Notes, adding to web 

journal, 325

O
Option-click, overriding 

automatic source 
selection, 95

Options pane
adding titles to 

maps, 152
customizing 

maps, 150
editing photos and 

text in books, 
153–155

formatting text, 
155–156

Ordering photo books, 
350–352

Origami theme, selecting 
for slideshow, 162

P
Pages, book

adding/deleting, 
344–347

changing layout of, 
135–137

deleting, 141–143
framing photos on, 

143–145
rearranging, 152–153
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selecting layout of, 
137–141

swapping page 
positions in photo 
book, 347–350

Panning
changing slideshow 

themes and 
music, 170–171

modifying Ken Burns 
effect, 171–173

Passwords, setting up Mac 
computers, 198

Paste command, 71
People, finding in photos. 

see Faces view
Photo books

adding map page, 
340–343

adding/deleting pages, 
344–347

creating, 330–332
customizing cover of, 

332–339
ordering, 350–352
swapping photos and 

page positions in, 
347–350

viewing photos by 
project, 231

Photo pop-up menu, 30
Photo quality, printing 

services and, 352
Photo streams. 

see My Photo Stream; 
shared photo streams

Photos
adding from email, 

232–233
adding text to email, 

23–24

albums. see Albums
arranging by faces. 

see Faces view
arranging by places. 

see Places view
assigning keywords 

to, 36–39
attaching to email, 23
beaming, 233–236
comparing, 34–36, 

258–261, 263
cropping. 

see Cropping 
photos

deleting, 15–18
deleting on iOS 

devices, 244–247
detecting similar, 265
editing. 

see Editing photos
emailing, 18–20
favorites, 253–254
filtering displayed 

photos, 268–271
flagging, 32–34, 

254–256
full-screen view, 

14–15
importing, 9–11, 240
managing. 

see Managing 
photos

moving and framing 
in theme, 22–23

placing into email 
theme, 20–21

rating, 29–32
review, 25, 50–51
searching, 43–44
selecting range of, 

262–264

sharing. 
see Sharing photos

sorting, 28
stylizing, 272–275
tagging with 

keywords, 256–
258

transferring to mobile 
devices, 49–50

viewing, 11–13, 227–
229

viewing on iOS 
device, 241–244

Photos app
adding photos to 

shared photo 
streams, 372–375

commenting on 
shared photos, 
378–380

creating shared photo 
streams, 369–372

deleting shared photo 
streams, 374

methods for receiving 
photos, 226

removing items from 
My Photo Stream, 
360–364

removing items from 
shared photo 
streams, 376–378

Pictures folder, creating 
iPhoto library, 3

Pins (location)
assigning location 

information, 67
clicking to show 

location name, 
64–65
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creating Smart Album 
from map, 75–76

moving, 68–69
Place Pin popover, 

341
removing, 72–73

Places theme, selecting for 
slideshow, 165

Places view
adding/removing 

locations, 
150–151

assigning locations, 
66–68

changing location 
names, 73

copying locations 
to other photos, 
70–71

creating Smart 
Albums from 
maps, 75–76

managing places, 
74–75

moving location pins, 
68–69

overview of, 62
removing location 

pins, 72–73
review, 79
viewing GPS-tagged 

images, 63–66
Playback, slideshow, 

308–311
PNG file format, 192
Postcard theme, 21
Posting photos

to Facebook, 77–78
to Flickr, 78
to Twitter, 79

Preferences
connecting to 

memory cards, 
9–10

email, 18–20, 24
iCloud, 200, 203, 

207–209
sharing, 78
system, 189, 197–202

Printing services
international 

availability of 
Apple print 
services, 134

for keepsake book, 
157–158

ordering books from, 
157–158

photo quality 
and, 352

Projects
adding, removing, 

reordering 
photos, 312–313

adding map page 
to photo book, 
340–343

adding maps and 
notes, 322–325

adding/deleting pages 
to/from photo 
book, 344–347

changing layout of 
web journal, 
318–320

changing themes 
and controlling 
playback, 
309–311

customizing cover 
of photo book, 
332–339

deleting, 353–354
making slideshows, 

306–308
ordering photo books, 

350–352
overview of, 303
posting web journals, 

316–318
printing photo books, 

330–332
resizing and 

reframing photos, 
325–328

review, 355
sharing slideshows, 

314–316
sharing to social 

networks, 
304–306

sharing web journals, 
328–330

swapping photo 
frames, 321

swapping photos and 
page positions 
in photo book, 
347–350

viewing, 231
Publish window, 

posting photos to 
Facebook, 78

Q
Quick Fixes

enhancing photos, 
87–88

rotating photos, 97
Quick Group 

window, assigning 
keywords, 43



394 Index

R
Range, of photos, 262–264
Rating photos

applying effects and, 
102–104

cropping and, 86–87
enhancing photos 

and, 88
fixing red-eye and, 91
overview of, 29–32
retouching photos 

and, 96
straightening photos 

and, 92
RAW format files

exporting photos to 
recordable DVD 
disc, 192

exposure correction 
and, 112

understanding photo 
formats, 182

Red-eye, removing, 89–91
Repair brush, repairing 

photos, 298–300
Restore option, Time 

Machine, 189–190
Retouch tool, Edit pane, 

93–96
Rotate tool, Edit pane, 96
Rule of thirds, 85–87

S
Saturation

adjusting, 288–289
increasing, 118–119
Quick Fixes, 87

Saved slideshows, types 
of slideshows in 
iPhoto, 161

Scroll bars, viewing 
photos and, 13

SD memory cards, 240. 
see also Memory cards

Searching iPhoto library, 
43–44

Selections, using Shift key, 
33, 35, 39, 42

Sepia tint
creating antique 

effect, 101
stylizing photos, 274

Settings
adjusting aspect 

ratio, 177
adjusting single item 

in slideshow, 
176–177

modifying pan and 
zoom of Ken 
Burns effect, 
171–173

slideshow options, 
163–164

Shadows
adjusting, 115
analyzing, 108–110
applying effects, 103
brightening, 285
enhancing photos 

with brushes, 295
improving shadow 

detail, 122–123
Quick Fixes, 87

Share button, 164
Shared photo streams

adding photos to, 
215–217, 372–375

commenting on 
shared photos, 
219–221, 378–380

creating on iOS 
devices, 369–372

creating on Mac 
computers, 
210–212

creating on Windows 
PCs, 212–214

deleting, 374
deleting entire photo 

stream, 214–215
removing items from, 

376–378
Sharing photos

by beaming, 233–236
overview of, 77
placing photos into 

email theme, 
20–21

posting to Facebook, 
77–78

posting to Flickr, 78
posting to Twitter, 79
review, 79

Sharing photos with 
iCloud
adding photos to 

shared photo 
streams, 215–217

commenting on 
shared photos, 
219–221

creating shared photo 
streams, 210–214

deleting entire photo 
stream, 214–215

importing photos 
from My Photo 
Stream, 206–208

My Photo Stream, 197
overview of, 195
removing photos 

from My Photo 
Stream, 205–206
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removing photos 
from shared 
photo streams, 
217–219

review, 222
setting up Mac 

computers, 
197–201

setting up photo 
sharing, 208–210

setting up Windows 
PCs, 201–203

uploading photos to 
My Photo Stream, 
203–204

what iCloud is, 196
Sharing photos with 

iCloud, on iOS 
devices
adding photos to 

shared photo 
streams, 372–375

commenting on 
shared photos, 
378–380

creating shared photo 
streams, 369–372

deleting shared photo 
streams, 374

iCloud Photo Sharing 
service, 368–369

overview of, 357
removing items from 

shared photo 
streams, 376–378

using My Photo 
Stream, 358

Sharing projects, 304–306
Sharing slideshows, 178, 

314–316
Sharing web journals, 

328–330

Sharpening
applying, 124–126
using Sharpness slider 

in conjunction 
with De-noise 
slider, 126

Shift-click
adding keywords 

to group of 
photos, 39

comparing photos, 35
managing 

keywords, 42
toggling between 

versions of photo, 
95–96, 102, 104

Show menu, Unplaced 
Photos option, 146

Size slider
retouching photos, 94
scaling photos, 22–23

Skin tones
fixing white balance, 

288–289
Saturation slider 

and, 119
Slideshows

adding, removing, 
reordering 
photos, 312–313

adding video to, 
173–175

adjusting settings 
of single item, 
176–177

changing themes and 
music, 170–171, 
309–311

controlling playback, 
309–311

creating slideshow 
albums, 164–165

deleting/rearranging 
photos, 166–169

exporting, 178–179
instant slideshow 

option, 162–164
making, 306–308
modifying pan and 

zoom of Ken 
Burns effect, 
171–173

overview of, 161
review, 178–179
setting aspect 

ratio, 177
sharing, 178, 314–316
viewing photos by 

project, 231
Smart Albums

creating, 47
creating from Faces, 

61–62
creating from maps, 

75–76
working with, 47–48

Social media
posting photos to 

Facebook, 77–78
posting photos to 

Flickr, 78
posting photos to 

Twitter, 79
sharing projects to, 

304–306
Softcover option, selecting 

book type, 133
Sorting photos, 28
Source list

Events option, 17
Faces option, 54
navigating iPhoto 

window, 6
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Smart Albums icons 
in, 48

Trash option, 16–17
viewing all photos, 13

Speed slider, playing 
slideshows and, 311

Split Event option, 
183–184

Split View
comparing 

photos, 263
thumbnail grid 

and, 261
Standard definition 

(480p), 178–179
Status bar, viewing import 

progress, 11
Storage capacity, 

iCloud, 358
Straightening photos

with Crop tool, 
281–283

Straighten tool, 91–92
Stylizing photos, with 

effects, 272–275
Subtitles. see Titles/

subtitles
Syncing photos, from Mac 

or Windows PCs, 
236–239

System Preferences, 189, 
197–202

T
Tagging photos, with 

keywords, 256–258
Temperature, adding 

weather frame to web 
journal, 323

Temperature controls, 
improving white 
balance, 126–128

Text
adding to email, 

23–24
editing in keepsake 

book, 153–155
entering and 

formatting, 
155–157

Themes
adding map page to 

photo book, 340
for book layout, 131
changing slideshow 

theme, 170–171, 
309–311

creating photo books, 
331–332

integrating map into 
book, 148

moving and framing 
photos in, 22–23

placing photos into 
email theme, 
20–21

selecting book theme, 
132–135

selecting slideshow 
theme, 162, 165

Thumbnails
comparing 

photos, 259
displaying, 14–15
filtering displayed 

photos, 268–271
Project view, 353
viewing photos by, 

241–244
TIFF file format, 192
Time, changing date and 

time of video clip, 
187–188

Time Machine
backing up 

photos, 189
restoring library with, 

189–190
Titles/subtitles

customizing cover 
of photo book, 
332, 339

entering and 
formatting 
text, 155

Toolbar, navigating iPhoto 
window, 6

Transition pop-up menu, 
slideshow settings, 
176–177

Trash
deleting photo 

books, 354
deleting photos, 346
emptying, 18
removing items from 

My Photo Stream, 
361–364

removing items from 
shared photo 
stream, 376–378

removing photos from 
slideshow, 312

viewing deleted 
photos, 16

Travelogue theme, 
331–332

Trim button, applying to 
video clip, 174–175

Twitter
posting photos to, 79
removing iPhoto 

accounts, 78
sharing photos via, 

304–306
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U
Undo button

Edit pane, 95
undoing adjustments, 

289–290
Unplaced Photos option, 

Show menu, 146
Uploading photos, 203–204

V
Video

adding to slideshows, 
173–175

changing date and 
time of clip, 
187–188

Viewing area
navigating iPhoto 

window, 6
rating photos, 31–32

Viewing photo location, 
on iOS devices, 248

Viewing photos
by events, 11–13
full-screen view, 14–15
on iOS devices, 

227–229
by ratings, 31
thumbnail view, 

241–244
view all option, 13

Vignette effect
creating, 101–102
stylizing photos, 

274–275
Volume, playing 

slideshows and, 309

W
Warmer button, applying 

effects, 104

Weather, adding weather 
frame to web journal, 
323–324

Web journals
adding maps and 

notes, 322–325
changing layout of, 

318–320
creating, 316–318
resizing and 

reframing photos, 
325–328

sharing, 328–330
swapping photo 

frames, 321
viewing photos by 

project, 231
White balance

fixing, 287–289
improving, 126–128
Quick Fixes, 87

White Point Levels slider, 
116–117

Windows PCs
adding photos to 

shared photo 
streams, 217

commenting on 
shared photos, 
220–221

creating shared photo 
streams, 212–214

deleting entire photo 
stream, 215

importing photos 
from My Photo 
Stream, 208

removing photos 
from My Photo 
Stream, 206

removing photos 
from shared 

photo streams, 
218–219

setting up iCloud on, 
201–203

setting up photo 
sharing, 209–210

syncing photos from, 
238–239

uploading photos 
to My Photo 
Stream, 204

Wire-bound option, 
selecting book 
type, 133

Wireless Beaming, sharing 
photos by beaming, 
233–236

X
XL (extra-large), selecting 

book type, 133

Z
Zooming

changing slideshow 
themes and 
music, 170–171

creating Smart Album 
from map, 75

fixing red-eye, 90
getting wider view of 

a location, 69
managing places, 

74–75
modifying Ken Burns 

effect, 171–173
retouching photos, 93
viewing photos and, 12
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